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یابی هر روز  عیبآنالیز و  فرآیند ،FPGAی مبتنی بر ها با رشد سایز و پیچیدگی طراحی

به نام  ISE Design Suite افزار نرمدر راهنمای پیش رو به تبیین توانایی بخشی از . شود میتر  سخت

ی این بخش برای استفاده در آنالیز و ها خواهیم پرداخت و قدم به قدم با ظرفیت 0ناظر شماتیک

 شویم. میمدار آشنا  یابی عیب

 دهد عبارتند از: میپاسخ  ها آنبه  Schematic Viewerمتداول که  سؤالاتبرخی از 

 طراحی را چگونه تفسیر خواهد کرد؟ ،ابزار سنتز 

  ؟شود میهدف نگاشته  یفنّاورطراحی چگونه به 

 کجاست؟ 2مسیر بحرانی 

ی ها ی مختلف طراحی توسط طراحها ی جدید قسمتها در طراحی ،مسئلهعلاوه بر این 

تنها مسئول بخش  ،و این در حالی است که هر شخص شود میمختلف از نقاط مختلف دنیا انجام 

نجاست که نیاز به یک ای .کند می تر سخترا  یابی عیبآنالیز و  فرآیندباشد. این روند طراحی  میخود 

 FPGA و Schematic Viewer ،PlanAheadیی نظیر ها . ابزارشود میابزار برای این کار احساس 

Editor  اند ایجادشدهبرای این کار. 

پردازیم. ابزاری که امکان نمایش و آنالیز  می Schematic Viewerدر این راهنما به توضیح 

 دهد. میطراحی از منظرهای متفاوت را به دست 

 

 

                                           
0 Schematic Viewer 

2 Critical Path 
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 دومفصل 

توصیف کلی : 2 فصل

Schematic Viewer 
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واسط  Schematic Viewerپردازیم.  می Schematic Viewerبه توصیف کلی این فصل  در

روی بخش دلخواهی از طراحی تمرکز کنید. این امکان در  ،دهد میقدرتمندی است که به شما اجازه 

 کند. میمورد نظر را فراهم  ی ترین دسترسی ممکن به نقطه واقع سریع

Schematic Viewer  ها آناز  دهد که برخی میامکاناتی را برای آنالیز در اختیار طراح قرار 

 عبارتند از:

  تنها با استفاده از چند واحد دلخواهکشیدن شماتیک طراحی 

 ها و خروجی ها استخراج ورودی 

  خواهیم نمیحذف واحدهایی که 

 ی قبلها آنالیز ی رفتن به تاریخچه 

  مختلف از یک  های شما تیککار کردن باNetlist 

0ی اساسی چون نمایش نمای ها دارای ظرفیت Schematic Viewerدر نهایت 
RTL ،

Netlistمسیرهای بحرانی در گزارش پس از مسیریابی و جایابی  تأخیرو گزارش  2سنتز تهای پس

 پردازیم. میاست که در زیر به اختصار به توضیح هر یک 

0- RTL View 

RTL View  شمای گرافیکی طراحی در سطحRTL  دهد. این شما توسط یک  میرا نشان

XSTکه توسط   ngr. فایل با پسوند
. این فایل در مراحل اولیه شود میائه ، ارشود میتولید  3

هدف از تولید این   .شود میصورت نگرفته است، تولید  .فنّاوریسنتز، زمانی که نگاشت 

                                           
0 RTL View 

2 Post-synthesis netlists 

3 Xilinx Synthesis Technology 

. Technology Mapping 
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نمایش توسط  RTL Viewerاست. در  HDLگرافیک به کد  ترین نزدیکنمایش  ،اتیکشم

 .شود میارائه  ها مالتی پلکسرها و ثبات، ها جمع کنندهی بزرگ نظیر ها بلوک

2- Post-synthesis netlists 

است  ngc.و نگاشت( فایلی با پسوند  سازی بهینهپست سنتز ) پس از  Netlistارائه گرافیکی 

توانند  می ها باشد. این المان می UNISIMموجود در کتابخانه Xilinxی اولیه ها که شامل المان

LUT ،DCM بافرهای ،I/O بررسی  ی و یا فلیپ فلاپ باشند. این شماتیک به طراح اجازه

 دهد. میی اولیه و در نظر گرفتن شرایط در این سطح را ها طراحی در سطح المان

3- Critical Path View  

. این شود میاز مسیریابی و جایابی ارائه پس  Netlistمسیر بحرانی طراحی در گزارش 

 دهد. مینشان  0پست سنتز فرق دارد و طراحی را در سطح تراشه Netlistگزارش با گزارش 

 

                                           
0 Slice 
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 Schematic Viewerبا جزئیات  ها آنیی وجود دارد که با انجام ها در طی این راهنما آزمایش

 Spartan®-3Eبا دستگاه هدف  0یک گام شمار ی از پروژه ها برای این آزمایش آشنا خواهید شد.

xc3s100e-4-vq100  ی ها . این پروژه در قالب مثالشود میاستفادهISE  مذکور نصب شده  افزار نرمبا

 است.

 ها را به ترتیب گفته شده انجام دهید. با این حال آزمایش ها که آزمایش شود میپیشنهاد 

تنها آزمایش همان بخش  توانید میمستقل از هم هستند و اگر مایل به یادگیری بخش خاصی هستید 

 را انجام دهید.

ی ها درست کرده و فایل ای جداگانهبرای پیش روی قدم به قدم برای هر آزمایش مسیر 

 آن کپی کنید. پروژه را در

 ها نمای کلی آزمایش -3-1

 ها جزئیات آزمایش ( 0-3) جدول

 جزئیات ها آزمایش

 Schematic Viewerانتخاب مد شروع   : خصوصیات اصلی0آزمایش 

  کار باSchematic Viewer 

 درک واسط Schematic Viewer 

 بزرگنمایی 

                                           
0 Stopwatch 
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 ها گسترش شماتیک 

 از شماتیک ها حذف المان 

 ی جدیدها رنگ کردن المان 

  ها به تاریخچه شماتیکبازگشت 

 ی شروع و پایانها استفاده از نشانه گذار 

 ی سلسله مراتبیها انتخاب بلوک  ی سلسله مراتبیها Netlistکار با  :2آزمایش 

 ی سلسله مراتبیها گسترش بلوک 

  شروع توصیف شماتیک توسط بلوک

Top-Level 

برای  Schematic Viewerاستفاده از  :3آزمایش 

 آنالیز زمانی

  در مشاهده مسیر بحرانیSchematic 

Viewer 

  تفسیر مسیر بحرانی توسط مسیرهای

 تأخیر

های شروع  لاستفاده از نشانگرهای سیگنا  ساده سازی تحلیل طراحی :.آزمایش 

 و پایان

 ی طراحیها حذف المان 

  استفاده از چند شماتیک برای یک

Netlist 

 ی ها شروع یک شماتیک جدید با المان

 انتخابی
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 ی مختلف برای ها استفاده از رنگ

 ی مختلفها المان

ی مختلف یک ها سازی پیاده ی مقایسه:5آزمایش 

 طراحی

  مقایسه دوNetlist از یک طراحی 

 ی بزرگها به کار گیری طراحی  ی بزرگها طراحی :1آزمایش 

به  Schematic Viewerاستفاده از  :2آزمایش 

 عنوان یک ابزار رایج

  استفاده ازCommand Line 

 نیازها پیش -3-2

باشد که عبارتند  می ISE افزار نرمد داشتن اطلاعات اولیه راجع به ی پیش رو نیازمنها آزمایش

 از:

 نحوه باز و بسته کردن یک پروژه 

  نحوه ایجاد فایلUCF ی زمانی به پروژهها و اعمال محدودیت 

  سازی پیادهنحوه اجرای یک 

  زمانینحوه استفاده از آنالیزکننده 

 در صورت آشنا نبودن با مفاهیم ذکر شده به راهنماهای دیگر از این مجموعه مراجعه کنید.



 : کار در آزمایشگاهسومفصل                                                ISEافزار  راهنمای استفاده از نرم

 

 

09 Copyright © 2013 ICEEP, University of Tehran                                                            

 

 ایجاد پروژه -3-3

مربوط را گشوده و در آن  ی پنجره File > Open Exampleبرای باز کردن پروژه مسیر  

شخص پروژه را م ی را انتخاب و در بخش پایینی آدرس ذخیره watchverپروژه   0-3مطابق شکل 

 کنید.

 
(1-3) شکل ایجاد پروژه گام شمار 

 Project Nevigatorتنظیم  -3-4

آن را روشن کنید. برای  ی زمینه پسکه  شود مییه صهتر دیده شدن شماتیک طراحی توببرای  

 RTL/Technologyروی   پنجرهبروید. در قسمت چپ  Edit > Preferencesاین کار به مسیر 

Viewers  کلیک کرده و واردColor Scheme  ی گزینهشوید. در نهایت Light Background Color 

Scheme  را انتخاب کنید وApply  را زده و سپسOK .کنید 
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(2-3) شکل شماتیک زمینه پستغییر رنگ  



 

 

  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 چهارمفصل 

 :1آزمایش: 4 فصل

 خصوصیات اصلی
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است که در  Schematic Viewerآشنایی با عملیات اصلی در  ،در آزمایش اول هدف

 .مورد استفاده قرار خواهند گرفت کرات بهی بعدی ها آزمایش

 ایجاد پروژه آزمایش -4-1

 مراحل گفته شده در فصل قبل ایجاد و تنظیمات آن را انجام دهید.پروژه گام شمار را توسط 

 و سنتز طراحی XSTتنظیمات  -4-2

 Process Propertiesکلیک راست کرده و   Synthesize - XSTروی  Processesدر بخش 

 .مطمئن شوید Keep Hierarchyپارامتر  بودن Noاز  و بازکنیدرا 

 
(1-4) شکل تنظیم پارامترهای سنتز 
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 عملیات سنتز را آغاز کنید. Synthesize – XSTبا دو با کلیک کردن روی 

 Schematic Wizard اندازی راه -4-3

د تا طراحی بر اساس یای را انتخاب کن های پایه باید المان ،شماتیک طراحی ی قبل از مشاهده

 نشان داده شود. برای شروع دو راه مختلف وجود دارد: ها آن

  شروع باExplorer Wizard:  ی پنجرهدر این حالت با استفاده از Explorer 

Wizard شوند. در این آزمایش از این حالت بهره  میی اولیه انتخاب ها المان

 گیریم. می

 شروع با شماتیک بلوک Top Level:  در این حالتExplorer Wizard  کنار

. در ادامه شود مینمایش داده   Top Levelگذاشته شده و شماتیک اولیه تنها با بلوک

شماتیک خود را گسترش  Schematic Viewerی ها با استفاده از توانایی توانید می

 دهید. و سطوح مختلف طراحی را مشاهده کنید. برای استفاده از این حالت به

 ارائه شده مراجعه کنید. 2مایش یی که در آزها آموزش

 View Technology ی گزینهروی  Proceess ی پنجرهپس از اتمام سنتز طراحی، از 

Schematic  کلیک کرده و یا مسیرTools > Schematic Viewer >Technology View .را بروید 

 را انتخاب کنید. Start with the Explorer Wizard ی گزینهباز شده  ی پنجرهدر 
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(2-4) شکل Explorer Wizardشروع با  

به سه  ها باز شده المان ی پنجره. در کردهای مورد نظر را انتخاب خواهید  در گام بعدی المان

ی ها شوند. از زیر مجموعه المان میتقسیم  Top Levelی ها و پورت ها ، سیگنال0اولیهی ها دسته المان

و  MACHINE/current_state_FSM_FFd1اولیه دو عبارت 

MACHINE/current_state_FSM_FFd1-In کنید. 2را انتخاب و اضافه 

                                           
0 Primitives 

2 Add 
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(3-4) شکل ی اولیهها انتخاب المان 

 ،فیلتر استفاده کنید ی گزینهاز  توانید میطولانی باشد  ها در صورتی که لیست المان

یی که ها وارد کرده تا تنها المان شده مشخصکه بخشی از نام عبارت مورد نظر را در کادر  ترتیب ینا به

 آن بخش را دارا هستند نشان داده شوند.

 
 

(4-4) شکل ها فیلتر کردن نام المان 

 ساخته شود. ها را بزنید تا شماتیک المان Create Schematicکلید 
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 Schematic Viewerاستفاده از واسط  -4-4

 باشد: میی زیر ها شامل بخش Schematic Viewer  ی پنجره

 
(5-4) شکل Schemativ Viewer  ی پنجره 

 پردازید. می ها اصلی که در آن به توصیف طراحی توسط المان ی پنجره (0

 Schematic Viewerنوار ابزار مخصوص  (2

 یی مانند بزرگنماییها  گزینه عمومی شامل( نوار ابزار 3

یی که در شماتیک وجود ها این قسمت دارای دو بخش اطلاعات مختلف است: المان (.

ی مربوط به آن را در ها ویژگی توانید می. با انتخاب هر المانی از شماتیک ها آنی ها دارند و ویژگی

 این قسمت مشاهده کنید.
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 بزرگنمایی -4-5

هم  Schematic Viewerتوابع در کارهای گرافیکی است. در  ترین اساسییکی از  بزرگنمایی

 دارد که عبارتند از: عمومی وجود نوارابزارعملیات بزرگنمایی در  5

 : بزرگنمایی

 : کوچک نمایی

 : نمایش نمای کلی طراحی

 کشید میادر : بزرگنمایی روی بخشی از طراحی که با مستطیل دور آن ک

این قسمت باید ابتدا بلوک را انتخاب  سازی فعال) برای  شده انتخاب: نمایش بلوک 

 کنید(

باشد. علاوه بر  می دسترسی قابلهم  View > Zoomاز طریق مسیر  چنین هماین عملیات  

 توان بزرگنمایی را تغییر داد. میو کلید چرخشی موس  Ctrlتوسط کلید  ها این

 Schematic Viewگسترش  -4-6

راه نیاز به گسترش آن داشته باشید.  ی وقتی نمای شماتیک را ساختید ممکن است در میانه

، بلوک، پین یک بلوک و پورت. 0یی که در نمای شماتیک قابل گسترش هستند عبارتند از: گرهها المان

و یا  2درایور ی گزینهبرای گسترش هر کدام از این موارد روی المان مورد نظر راست کلیک کرده و 

                                           
0 Net 

2 Driver 
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روی هر کدام از  توانید میمایش ماتیک این آزو یا ورودی/ خروجی را انتخاب کنید. در ش 0بار

 متفاوت است. ها  گزینهراست کلیک کرده و مشاهده کنید که بسته به نوع المان و مکان آن  ها المان

 

(6-4) شکل (1گسترش شماتیک ) 

 
(7-4) شکل (2گسترش شماتیک) 

 مثال:

                                           
0 Load 
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 Show ی گزینهرا انتخاب و روی آن راست کلیک کنید و  lut3از  I1به عنوان مثال پین 

Next Drive (Output Pin) .را بزنید. شکل زیر را مشاهده خواهید کرد 

 

(8-4) شکل I1گسترش پین  

 انجام دهید. I0مشابه همین عمل را برای 
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(9-4) شکل I0گسترش پین  

این  اند. چین مشخص شده با نقطه ها وککنید برخی اتصالات بین بل میهمان طور که مشاهده 

ی دیگری به این گره متصل هستند که با راست کلیک کردن روی گره ها بدان معناست که بلوک

این کار  I1شوند. به عنوان مثال اگر روی گره متصل به  میهم به شماتیک اضافه  ها مربوطه آن بلوک

 آید. میرا انجام دهیم شکل زیر به دست 
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(10-4) شکل I1گسترش گره متصل به  

 استفاده از نشانگر شروع/ پایان سیگنال  -4-7

دهد. برای استفاده از این  مینشانگر شروع/ پایان به راحتی منبع و مقصد سیگنال را نمایش 

 اهر شوند.ظ علائمدلخواه کلیک کرده تا این نشانگر روی سیگنال 
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(11-4) شکل نشانگر شروع و پایان سیگنال 



 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 پنجمفصل 

 :2آزمایش: 5 فصل

های Netlistکار با 

 مراتبی سلسله
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سلسله مراتبی  ها با بلوک های سلسله مراتبی و نحوه کارNetlistدر این آزمایش به بررسی 

 پردازیم. می

 ایجاد پروژه  -5-1

 Synthesize - XSTروی  XSTتنظیمات  برای مشابه آنچه گفته شد بسازید. و ای پروژه

 .کنید Yesرا Keep Hierarchy ی گزینهشوید و  Process Propertiesو وارد  کنید راست کلیک 

  سپس سنتز را شروع کنید.

 Schematic Wizard اندازی راه -5-2

باز شده  ی پنجرهرا بزنید، سپس در   View Schematic Technologyپس از اتمام سنتز 

Start With the Explorer Wizard .را انتخاب کنید  

 Createو  نتخاب کنید و آن را اضافه نماییدرا ا MACHINEباز شده  ی پنجرهدر 

Schematic .را بزنید 

 
(1-5) شکل انتخاب سلسله مراتبی 

 :شود میدر نهایت نمای زیر نمایش داده 
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(2-5) شکل شماتیک سلسله مراتبی 

 دو راه برای تشخیص این بلوک از حالت اولیه وجود دارد:

 ی سلسله مراتبی در چهار گوشه خود یک مثلث کوچک دارند.ها تمام بلوک (0

های داخلی هم دارند که این از تو رفتگی خط پین در  ی خارجی پینها علاوه بر پین  (2

 .شود میبلوک مشخص داخل 

 ی سلسله مراتبیها گسترش بلوک -5-3

 کلیک کنید تا گسترش یابد. STRTSTOPک موجود روی داخل و خارج سیگنال یدر شمات
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(3-5) شکل گسترش سیگنال از داخل و خارج 

 را بزنید. Show Next Load (Input)Pin ی گزینهراست کلیک کرده و  CLKENروی 

 
(4-5) شکل گسترش بلوک 

 ها نمایش محتوی بلوک -5-4

 Show block ی گزینهبرای نمایش کل محتوی یک بلوک روی آن راست کلیک کرده و 

contents  با زدن  توانید میرا انتخاب کنید. به همین ترتیب   ی گزینهرا انتخاب و یا از نوار ابزار

Hide Block Contents .محتوی را حذف کنید 
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(5-5) شکل MACHINEمحتوی بلوک  

 1گسترش پایین به بالا -5-5

خواهیم با  میسر و کار داشتیم، در این بخش  2جای کار با گسترش بالا به پایینتا بدین 

ی باز را ببندید و کار را با کلیک بر روی ها این کار شاخه ایگسترش پایین به بالا آشنا شویم. بر

View Schematic Technology   و انتخابStart With the Explorer Wizard .آغاز کنید 

را انتخاب و  Current_state_FSM_FFd3_Inالمان  MACHINE > Primitivesاز شاخه 

 را بزنید. Create Schematicاضافه کنید و 

  
(6-5) شکل گسترش پایین به بالا 

 Show All Blockسپس بلوک را روی شماتیک انتخاب کرده و با راست کلیک روی آن 

Inputs .را بزنید 

                                           
0 Bottom-Up 

2 Top-Down 
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(7-5) شکل ها گسترش تمام ورودی 

مقایسه کرده و  5-5در شکل  MACHINEشکل بالا را با شمای کلی  توانید میحال 

 ی مختلف را در هر دو شکل با هم تطبیق دهید.ها بلوک

به دست  MACHINEدر نهایت کل محتوی بلوک  ها با گسترش مرحله به مرحله تمام بلوک

 آید. می
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(8-5) شکل MACHINEگسترش کامل پایین به بالای بلوک  

از نوار ابزار کلیک کنید. در این حالت  به بالا روی کلیدبرای عبور از حالت پایین 

ی بلوک بالاتر را هم ها ورودی و خروجی توانید میو شما  شود میشماتیک به یک سطح بالاتر منتقل 

 گسترش دهید.

 

(9-5) شکل رفتن به سطح بالاتر شماتیک 

 Top-Levelشروع گسترش شماتیک توسط بلوک  -5-6

 Start with theرفی کردیم که تنها از اولی یعنی شروع معتا بدین جای کار دو مد برای 

Explorer Wizard   استفاده شد. در این قسمت به معرفی مد بعدی به نامStart with a schematic 
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of the top-level block پردازیم. می 

کلیک کنید و  Vie Technology Schematicشماتیک قبل را ببندید و دوباره روی  ی شاخه

 دوم را انتخاب نمایید. ی گزینهباز شده  ی پنجرهاین بار در 

 
(10-5) شکل Top Levelشروع با مد  

 پس از این مرحله شکل زیر را مشاهده خواهید کرد:

 

(11-5) شکل Top Levelبلوک  

شماتیک خود  ،ی گسترش که تا کنون گفته شدها با تمام روش توانید میبعد از این مرحله  
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 را گسترش دهید.



 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 ششمفصل 

 :3آزمایش: 6 فصل

 Schematicاستفاده از 

Viewer برای آنالیز زمانی 
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مسیریابی گزارش پس از  مسیرهای بحرانی توانید میبه راحتی  Schematic Viewerتوسط 

 آغازی برای گسترش شماتیک باشد. تواند یمرا مشاهده کنید که این خود 

 ایجاد پروژه -6-1

 گفته شد پروژه گام شمار را بسازید. 3همانند آنچه در فصل 

 توصیف محدودیت زمانی -6-2

کنید برای این کار  ایجاد UCFابتدا باید یک فایل  Cross Probingبرای استفاده از مکانیزم 

باز شده  ی پنجرهدر  .را بزنیدNew Source روی پروژه راست کلیک کرده و   Design ی پنجرهدر 

Implementation Constraint File  را انتخاب و نامStopwatch  .را انتخاب کنید و فایل را بسازید 
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(1-6) شکل UCFایجاد فایل  

تنظیمات را مطابق شکل زیر وارد کرده را بزنید و  Tools > Constraints Editorسپس مسیر 

 را بزنید. Validate Constraints ی گزینهو 

 
(2-6) شکل وارد کردن دستی محدودیت زمانی 

 XSTتنظیمات  -6-3

 Process Propertiesراست کلیک کنید و  Synthesize – XSTروی   Process ی پنجرهدر 
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 ی پنجرهرا از   Implement Designکنید. در انتها  yesرا   Keep hierarichy ی گزینهو  بازکنیدرا 

Process   و جایابی،  مسیریابیبزنید. پس از انجام عملیاتAnalyze Post-Place & Route Static 

Timing  بازکنیدرا مطابق شکل زیر. 

 
(3-6) شکل آنالیز زمانی پس از مسیریابیباز کردن  

 ای مانند شکل زیر باز خواهد شد.  پنجره

 
(4-6) شکل آنالیز زمانیگزارش  
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همان طور که مشاهده  .بگردید Maximum Data Pathدر گزارش باز شده دنبال عبارت 

روی آن راست کلیک کنید و است،  تأخیرمسیر وجود دارد که اولی دارای بیشترین مقدار  9 ،کنید می

 را بزنید. Show in Technology Viewer عبارت

 
(5-6) شکل Technology Viewerرفتن به  

که در آن مسیر بحرانی زمانی نمایش داده  شود میمانند شکل زیر باز  ای پنجرهدر انتها 

 .شود می

 
(6-6) شکل نمایش مسیر بحرانی روی شماتیک 

از نوار ابزار کلیک کنید و در  شماتیک هستید روی آیکون  ی پنجرهزمانی که روی 
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 را انتخاب کنید. ها  گزینهباز شده مانند شکل زیر  ی پنجره

 
(7-6) شکل تأخیرانتخاب نام پین و میزان  

. این مقادیر را با اعداد موجود در شود میهر پین روی آن نوشته  تأخیربا این کار میزان 

 گزارش زمانی مقایسه کنید. مشاهده خواهید کرد که یکسان هستند.

 
 

(8-6) شکل گزارش زمانیروی شماتیک  یرهاتأخنمایش  

 



 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 هفتمفصل 

 :4آزمایش: 7 فصل

 تحلیل طراحی
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و این موضوع تحلیل  یابد میتر شدن طراحی افزایش  با پیچیده ها در یک طراحی تعداد المان

 یلهوس بهکه  شود مییی ارائه ها کند. در این آزمایش روش میرا با مشکل مواجه  ها طراحی گونه ینا

 .شود می تر آسانپیچیدگی مدار کمتر شده و تحلیل آن  ها آن

 XSTایجاد پروژه و تنظیمات  -7-1

پروژه گام شمار را توسط مراحل گفته شده در فصول قبل ایجاد و تنظیمات آن را انجام 

 دهید.

 و سنتز طراحی XSTتنظیمات  -7-2

 Process Propertiesکلیک راست کرده و   Synthesize - XSTروی  Processesدر بخش 

 .مطمئن شوید Keep Hierarchyپارامتر  بودن Noاز  و بازکنیدرا 
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(1-7) شکل تنظیم پارامترهای سنتز 

 عملیات سنتز را آغاز کنید. Synthesize – XSTبا دو با کلیک کردن روی 

 Netlistمختلف از یک  های شما تیککار با  -7-3

آن  برای کار در این بخش یک فلیپ فلاپ را انتخاب کرده و به بررسی ورودی و خروجی

پردازیم. برای راحتی کار ورودی را در یک صفحه و خروجی را در یک صفحه دیگر قرار  می

 دهیم. می

 View Technology ی گزینهروی  Proceess ی پنجرهپس از اتمام سنتز طراحی، از 

Schematic  ی گزینهباز شده  ی پنجرهکلیک کرده و در Start with the Explorer Wizard  را

 انتخاب کنید.
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 Createکنید و  Addرا یافته و  MACHINE/current_stater_FSM-FFd1 بانامفلیپ فلاپ 

Schematic  را بزنید. روی شماتیک فلیپ فلاپ راست کلیک کرده وAdd Input Cone .را بزنید 

 
(2-7) شکل Add Input Coneانتخاب  

 آید. میشکل زیر به دست 

 
 Add Input Cone (3-7) شکل

را بزنید و در   Create Schematicدوباره بازگشته و  Stopwatch.ngcحال به شاخه 
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را بزنید. شکل زیر به  Add Output Coneشماتیک جدید روی فلیپ فلاپ راست کلیک کرده و 

 آید. میدست 

 
 Add Output Cone (4-7) شکل

ی هر ها و تعداد بلوک یچیدگیپکنید با این کار میزان  میهمان طور که در دو شکل مشاهده 

 کند. می تر آسانو این کار تحلیل طراحی را  شود میشماتیک نسبت به نمایش کلی کم 

ی شماتیک ها ایجاد شماتیک جدید با استفاده از المان -7-4

 جاری

به تمرکز روی آن  مند علاقهو  یداکردهپفرض کنید که در حین عملیات خطایابی منبع خطا را 



 : تحلیل طراحی.: آزمایش هفتمفصل                                     ISEافزار  راهنمای استفاده از نرم
 

 

53 Copyright © 2013 ICEEP, University of Tehran                                                            

 

آید. در این حالت  میی با تعداد المان زیاد پیش ها در طراحی خصوص بهمنبع هستید. این شرایط 

ل این معمو حل راهیی اضافی را حذف کنید. ها المان مورد نظر را انتخاب کنید و یا المان توانید می

و  بر زمانکنید. اما این کار  مورد نیاز را در آن ایجاد یها الماناست که شماتیک جدیدی ایجاد و 

آن    مورد نظر را انتخاب و توسط آیکون یها موثر است. راه حل بهتر این است که المانغیر

 مانند. میحذف شده و بقیه باقی  ها المان

 
(5-7) شکل ها انتخاب المان 
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(6-7) شکل ها حذف بقیه المان 

 ها ی مختلف برای تشخیص بهتر المانها استفاده از رنگ -7-5

ی مختلف کمک زیادی ها بسیار زیاد است، استفاده از رنگ ها یی که تعداد المانها در شماتیک

را بروید و از  Edit > Preferenceکند. برای این کار مسیر  می ها به دسته بندی و بهتر دیده شدن المان

مانند  ای پنجرهرا انتخاب کنید.  User Color Rules ی گزینه، RTL/Technology Viewersشاخه 

 شکل زیر باز خواهد شد:
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(7-7) شکل انتخاب رنگ ی پنجره 

را وارد کرده  ff_fd_colors  . در قسمت نام عبارتشود میزیر باز  ی پنجره Newبا انتخاب 

 را بزنید. Newو 
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(8-7) شکل (2انتخاب رنگ) ی پنجره 

عبارت  Operatorو در بخش  Block Typeنام  Property Nameدر قدم بعد برای قسمت 

Matches(Wildcard)  و برای مقدار عبارتfd* .را انتخاب کنید 
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(9-7) شکل (3انتخاب رنگ) ی پنجره 

 کنید. OKرنگ مورد نظر را انتخاب و  Light Backgroundبعد در قسمت  ی پنجرهدر 



 : تحلیل طراحی.: آزمایش هفتمفصل                                     ISEافزار  راهنمای استفاده از نرم
 

 

51 Copyright © 2013 ICEEP, University of Tehran                                                            

 

 
(10-7) شکل (4انتخاب رنگ) ی پنجره 

 دهد. المان مورد نظر در شماتیک تغییر رنگ می دینیب یمهمان طور که در شکل 
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(11-7) شکل رنگ المان در شماتیک تغییر 

های جدید تغییر  المان ،که وجود دارد این است که اگر شماتیک گسترش یافته باشد ای نکته

 کنید. رفعالیغاز نوار ابزار را   ی گزینه ها دهند. برای مشاهده تغییر رنگ این المان میرنگ ن

 
(12-7) شکل ی جدیدها کردن المانرنگ  



 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 فصل هشتم

 :5آزمایش: 8 فصل

 سازی مقایسه دو پیاده
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تراشه و سرعت وجود دارد. گاهی برای  ی توان و سطحها محدودیت معمولاًدر یک طراحی 

را تغییر داد. برای این کار  سازی پیادهباید کد اصلی و یا تنظیمات سنتز و  ها ارضای این محدودیت

 نهایی را بدانیم. سازی پیادهابتدا نیاز است که اثر اعمال این تغییرات بر 

دهد که  میاین را  ابزار مناسبی است. زیرا امکان Schematic Viewerبرای این کار 

Netlist ی مختلف از یک طراحی را مشاهده و با هم مقایسه کنید. توجه داشته باشید که این کار ها

ی پس از نگاشت و ها Netlistو  شود میی پست سنتز انجام ها Netlistو  XST RTL viewبرای 

 شوند. مین ارائهجایابی و مسیریابی در این بخش 

 XSTایجاد پروژه و تنظیمات  -8-1

پروژه گام شمار را توسط مراحل گفته شده در فصول قبل ایجاد و تنظیمات آن را انجام 

 دهید.

 و سنتز طراحی XSTتنظیمات  -8-2

 Process Propertiesکلیک راست کرده و   Synthesize - XSTروی  Processesدر بخش 

 و عملیات سنتز را آغاز کنید. .مطمئن شوید Keep Hierarchyپارامتر  بودن Yesاز  و بازکنیدرا 

و وارد شاخه  گذاشته default_run.ngc آن را نامبگیرید و  stopwatch.ngcفایل  کپی از یکسپس 

Xilinx Specific Options  ی گزینهشوید و Register Balancing  راyes .کنید 
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(1-8) شکل Register Balancingتنظیم  

 Netlistبارگذاری و مقایسه دو  -8-3

 Start with theو مد  را بزنید View Technology Schematic ی گزینه ،از شاخه سنتز

Explorer Wizard  باز شده روی  ی پنجرهرا انتخاب کنید. درMACHINE  کلیک کرده و شماتیک

 را ایجاد کنید.

 Start with theو مد  بازکنیدرا  default_run.ngcفایل  File > Openبا استفاده از مسیر 

Explorer Wizard  را انتخاب کنید. برای این فایل همMACHINE  را انتخاب و شماتیک را ایجاد

 کنید.

نشان  زمان همرا انتخاب کنید تا هر دو شماتیک به صورت   ی گزینهاز نوار ابزار بالایی 

 ی دو طراحی را مشاهده کنید.ها تفاوت توانید میداده شود. به این صورت 



 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 نهمفصل 

 :6آزمایش: 9 فصل

 های بزرگ طراحی
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آنالیز  فرآیندبزرگ وجود دارد که  یها طراحی سازی پیادهی جدید امکان ها FPGAدر  امروزه

توانند تا صدها هزار المان طراحی را شامل شوند. بنابراین  می ها طراحی ینتر بزرگای دارند.  پیچیده

 خواهد بود. فایده یبکل طراحی در یک شماتیک عملی  ی مشاهده

 صورت بهی بزرگ را در شماتیک ها تا چگونه طراحی یابید یدرمدر این فصل طی آزمایشی 

 اهده کنید.کارا و مفید مش

 سلسله مراتبی Netlistاستفاده از  -9-1

کامل سلسله مراتبی است، لذا از این امکان  صورت به XST RTL Viewer که ییازآنجا

استفاده  یازموردنی ها ی بخشئتوان برای پیدا کردن دید کلی نسبت به طراحی و سپس بررسی جز می

 کرد.

XST  کامل و یا تا یک حد سلسله  صورت بهدهد که طراحی را  میاین امکان را به شما

کند و اثر نامطلوب روی  میحداکثر طراحی جلوگیری  سازی بهینه. البته این کار از یددار نگهمراتبی 

سلسله مراتبی باید از ارضا شدن  صورت بهکارایی مدار دارد. بنابراین هنگام استفاده از سنتز 

 ی مطمئن باشید.ی طراحی و هدف طراحها محدودیت

ی قبلی پروژه گام شمار را ساخته، سپس ها بنابراین در ابتدا طبق روند گفته شده در فصل

. در این قسمت اگر بازکنیدرا  Process Propertiesکلیک راست کرده و   Synthesize - XST روی 

را روی  Keep Hierarchy ی گزینهسلسله مراتبی پیاده شود، تنها باید  صورت بهخواهید طراحی  می

Yes  .تنظیم کنید 
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 استفاده از صفحات مختلف شماتیک  -9-2

است. بنابراین  یرشاخهزدر ساختار سلسله مراتبی هر مرحله از طراحی خود دارای هزاران 

 استفاده کنید. Netlistاز چند شماتیک برای یک  توانید مییی از طبقات مختلف ها برای دیدن بخش

و  View Schematic Technology ی پنجرهبرای این کار پس از سنتز مدار و باز کردن 

که شما هر بار که  شود میباز  ای پنجره Start with the Explorer Wizard ی گزینهانتخاب 

را  Create Schematicکنید و گزنه  می Addخواهید شماتیکی ایجاد کنید اعضای مورد نظر را  می

 Removeنظر ایجاد شد، به همان صفحه برگشته اعضای قبل را  مورداینکه شماتیک  بعد زنید یم

. به شود میکنید. این بار شماتیک دوم با اعضای جدید ساخته  می  Addکنید و اعضای جدید را  می

 ی مختلف مدار ساخته و طراحی را آنالیز کنید.ها زیادی از بخش های شما تیک توانید میهمین ترتیب 

 
(1-9) شکل Netlistمختلف یک  های شما تیک 

 



 

 

 

  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 دهمفصل 

 :7آزمایش: 11 فصل

 Schematicاستفاده از 

Viewer  به عنوان ابزار

 رایج
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وجود ندارد. با این  0به عنوان یک ابزار رایج Schematic Viewerامکان نمایش  ISEدر 

 XSTیا  XST RTL Viewبرای این محدودیت وجود دارد که به شما امکان پی گیری  یحل راهحال 

post-synthesis netlists  دهد. میرا netlist هایPost-map و Post-place and route   در این بخش

 شوند. میپشتیبانی ن

 به عنوان یک ابزار رایج است.  Schematic Viewerهدف از انجام این آزمایش استفاده از 

 XSTایجاد پروژه و تنظیمات  -11-1

پروژه گام شمار را توسط مراحل گفته شده در فصول قبل ایجاد و تنظیمات آن را انجام 

 دهید.

 و سنتز طراحی XSTتنظیمات  -11-2

 Process Propertiesکلیک راست کرده و   Synthesize - XSTروی  Processesدر بخش 

 .مطمئن شوید Keep Hierarchyپارامتر  بودن Yesاز  و بازکنیدرا 

ببندید. توجه داشته  File > Close Projectعملیات سنتز را انجام داده و پروژه را از طریق 

 همچنان باز باشد. Project Nevigator باشید که 

را  stopwatch.ngc بانامپروژه  post-synthesis XSTفایل  File > Open Fileاز مسیر 

ای مانند آنچه در فصول  صفحه را انتخاب کنید. Start with the Explorer Wizardو مد  بازکنید

                                           
0 Standalone 
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 شماتیک پروژه را ایجاد کنید. توانید میو  شود میباز  ،گذشته دیدید

 
(1-10) شکل جاد شماتیکای ی  پنجره 

 

 

 

 

 

 



 

 

 نامه واژه: 11 فصل

 : 1 فصل
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A 

Add اضافه کردن 

B 

Bottom-Up پایین به بالا 

C 

Critical Path 
 مسیر بحرانی

D 

Driver 
 درایور

E 

F 

G 

H 

I 

J 
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K 

L 

Load 
                                                                                  بارگذاری

M 

N 

Net گره 

O 

P 

Post-synthesis netlist 
Netlist پس از سنتز 

Primitive 
                   اولیه

Q 

R 

RTL View  نمایRTL 

S 

Schematic Viewer 
 شماتیک اظرن

Slice 
                            تراشه
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Standalone 
 رایج

Stopwatch 
 گام شمار

T 

Technology Mapping 
 فنّاورینگاشت 

Top-down 
                                                                              بالا به پایین

U 

V 

W 

X 

Y 

Z 

                 

 


